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1. Introduction to Discoverer Viewer 

  

 
1.1 What is Discoverer? 
Discoverer 11g is an ad-hoc query, reporting and analysis tool that allows 
users to gain access to information from CUFS Live. It differs from other 
CUFS enquiry and reporting options because it allows more bespoke query 
definitions across multiple departments (for users with multi-department 
access rights). 
 

1.2 What is Viewer? 
The Viewer function of Discoverer allows users to interrogate CUFS data 
using pre-defined query worksheets contained in workbooks. 
 
Users are offered flexible parameters to customise the query templates whilst 
avoiding the need to be conversant with specialist database query language 
and design techniques. 
 
Viewer users run the queries and return the results in a form where they can 
modify layouts and formats before saving and/or exporting the results. 
 
The Viewer retrieves real time data from CUFS Live. 
 

1.3 Access to Viewer 
Access to Viewer is from within CUFS Live using a responsibility from the 
U.F.S. E-Business Suite Navigator page. 
 
Existing Discoverer users will automatically be given a Viewer responsibility in 
CUFS Live. 
 
New users will be given access to the Viewer by making a request through 
their Key Contact to CUFS helpdesk. 

 
 
 
 Users will have different 
 levels of access to Viewer 
 based on the responsibilities 
 they are given. 
 
 
 

 
A central responsibility such as 

 AG DISCOVERER VIEWER 
 will have wider access to data  

than say RA DISCOVERER 
 VIEWER. 

Functionality in the Viewer is the 
 same for everyone, regardless of 
 responsibility. 
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1.4 Preferences in Viewer 
 

The main options under the Preferences link concern the settings for 
managing data retrieval.  The screen shot below shows the Query Governor. 
 

 
Each of the first three settings can be enabled/disabled by using the tick box. 
 

Warn me if predicted time…these estimates are not always reliable. With 
this setting enabled, Discoverer will ask whether the user wishes to proceed 
with a query whenever the estimate exceeds the Query Governor setting. 
 

Prevent queries running longer than….!! this setting should always be 
enabled and queries should not run for excessive periods. If they do, it is likely 
that the data range is too large, or the parameters are inappropriate.  
Excessive run times will take resource from other CUFS Live users  
 

Limit retrieval data to….an absolute limit on the number of records retrieved.  
 
     Take care to review this regularly if setting a low limit. 
 

Retrieve data incrementally……this setting specifies the size of each 
“batch” of records within a total set – it does not limit the total records 
retrieved and the user is prompted until all records are returned. 
 

Cancel list of values retrieval….Use this field to define the maximum time 
you want to wait while Discoverer retrieves list of values items. 
 

Fan Trap Detection 
Leave this ticked to avoid potentially erroneous data or slow queries. 

 

Tip 
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2 Workbooks and Worksheets 
  

 

2.1 Access to workbooks 
 
Workbooks are created by authors using the Discoverer Plus software. The 
authors are the “owners”. Viewers are given shared access to the workbooks 
by the Central Reporting Team (see 2.1 below). 
Each workbook will contain at least one worksheet query based on a CUFS 
module. Users will see data from the query based on the access rights of the 
responsibility being used to access the Viewer. 
 
Viewers can save their own version of a shared workbook (see section 4.5 
below) 
 
Note:  Saving a new version of a workbook deletes all sharing that 
  applied to the old version 
 

2.2 Workbook listings 
 
After selecting a Viewer responsibility you are presented with the Workbooks 
listing. This is the “home” page for Viewer and is the only menu path within 
the responsibility 
 
Shared workbooks 
The Finance Division Reporting Team will make workbooks available by 
“sharing” with Viewers in two ways: 
 

1. Sharing a workbook with all users who have a particular 
responsibility 

2. Sharing workbooks with selected users 
 
Workbooks are listed alphabetically and each one has a description to define 
the data being retrieved and the conditions that will limit the query results. 
 
The search box allows the Viewer to filter on the workbook name 
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Expanding a Workbook 
 
Clicking on the blue arrow beside a workbook reveals the Sheet(s) within the 
workbook. 
 
Some workbooks will have only one sheet, others have more. For example a 
workbook showing General Ledger balances may contain four sheets – with 
balances for each quarter of a financial year. 
 
 

 
 
 
Expand All/Collapse All 
To see (or hide) the contents of every workbook, click on the Expand 
All/Collapse All links 
 
 

 
 
 
Focus on a workbook 
The left-hand column of the workbook listing page offers the focus option. A 

single workbook and the sheets within it are returned by clicking on the 
symbol 

 

To go back to a full workbook listing, click on the  
link. 
 



Finance Training  Page 6 
Discoverer Viewer User Manual 1.02 11g2 

3 Running a worksheet query 
  

 
 

3.1 Running a query with no parameters 
 
The workbook description will set out the scope and the type of data to be 
returned by the query.  
Some queries will run without specifying any parameters beforehand. The 
data is limited by the underlying workbook conditions which often restrict 
data using account code and date ranges. 

 
3.2 Running a query with parameters 
 
Most workbook queries present the Viewer with parameter choices before 
running. These are in addition to conditions created by the workbook owner 
 
Example: For General Ledger balances, the conditions may limit the 

query to the 2008-09 financial year. 
 
  In addition, the Viewer will be offered parameters to customise 
  the data based perhaps on selected account codes or periods 
  within the 2008-09 year. 
 

 
 
 

*  indicates mandatory field 
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3.3 More about parameter selection 
 
The workbook author will decide the parameter settings and the rules for 
selecting parameters 
 
Entering parameter values 
 
1) Parameter selections can be either a single value, a range of values 
 (from/to) or a selection of values 
 

 
 
2) Some parameter choices are mandatory – a value (or values) must be 
 entered – indicated by the asterisk * symbol 
 
3) Some parameter choices offer lists of values to select from: 
 

 
 
4) Some parameters are case sensitive (this will normally be stated if 
 case sensitivity is on) 
 
Take care when entering parameters because input errors or mistyping 
will lead to either no data or the wrong data being returned 
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3.4 Query runtime estimates and elapsed time 
 
Once parameters are entered and 
the Go button is clicked, the query 
will start to run. 
 
If your Preferences (1.4 above) are 
set to give a predicted time for the 
query, you will be asked if you wish 
to proceed, otherwise the Query 
Progress window will display until: 
 
- the query completes and data 
 is returned 
- the query completes and no 
 data is returned 
- the query times out 
 
A query that is running will refresh itself every few seconds, so the user does not 
need to click on the Refresh button 

 
Estimated run time 
Some queries will give an estimated run time, but for some it will be unknown. 
The Viewer does not always accurately predict query run times but the user 
has the option to cancel a query at any time by clicking the button. 
 

3.5 Cancelling a query 
 
If the Viewer does opt to cancel a query, the system will begin the cancel 
routine and confirm the new status. 
 

 
 
3.6 Re-running a query 
 
After cancelling, the user can choose to run the query again by simply clicking 
the Run now button. 
However, the user will often wish to change one or more parameters before 
re-running the query or just return to the Workbooks page. In both cases, click 
on the Workbooks >  link 



Finance Training  Page 9 
Discoverer Viewer User Manual 1.02 11g2 

4 Viewing, modifying and saving query results 
  

 

4.1 Viewing the data 
 
When the query has finished running, the data will be returned as a table. 
 
In the column header area, in blue type the total number of rows of data is 
shown and the number of columns that are being displayed (the default view 
may be less than the actual number of columns returned – this view option 
can be changed – see below) 
 

 
 
Scrolling up and down 
In the column header, the Down link acts as scroll button to show the next set 
of records in the query.  
The default setting is to display 25 rows of data at a time; this can be changed 
by clicking the arrow. The options are 1, 5, 25 or 100 rows 
 
Rows and Columns tools link 
The display setting for the number of rows can be customised up to a 
maximum of 999 by clicking the Rows and Columns link as illustrated below 
 

 
 
The number of columns displayed can also be changed here – also up to 999. 
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4.2 Changing the worksheet options 

 
 
The user can change the view of the data in a number 
of ways – without having to rerun the query.  
 
Note: All worksheet changes can be reversed by 
using Revert to Saved at any time 
 
 
Click on the Worksheet Options link to change the 
settings (see screen shot below). 
 

 
 
 
Title area (Workbook name) 
The author of the workbook will give each query a name and may also add a 
field to display the time and date of the query execution. 
This will display at the top of the web page. 
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Text area (Workbook conditions) 
Users will need to know how the workbook data is restricted – by the 
conditions the author has applied to the query. These and other notes are 
displayed below the data table.  
 
 

 
 
Null values 
Sometimes, the data will contain cells with nothing  - NULL - in them (as 
opposed to zero) The user can choose to show these cells as either “NULL”, 
“n/a”, “-“  or simply blank (NULL is the default) 
 

 
4.3 Changing the data layout 
 
Changing column order 
 
Click on the Layout link on the Tools menu. Three boxes appear which allow 
the user to move columns left and right 
 

 
   
 

 If you wish to hide a column from view, move it to the right hand 
 side, then use Rows and Columns to reduce the number of 
 columns displayed – excluding the rightmost column. 
 

Alternatively, columns can be hidden as part of the Sorting functions (see 
Section 4.6 below  
 
 
Note: Column order can also be changed by using the More…  link – see 4.4 

below for more information on re-arranging columns and creating page 
items 

 
 

Tip 
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4.4 Creating a page item (also filtering data) 
 
The Viewer allows one or more columns to be moved up as Page Items.  
The page item can then be filtered for a single value, creating Pivot Table 
style three dimensional data layout. 
 
Steps: Staying in the Layout menu, click on the More… link 
  Choose a column heading e.g. Cost Centre and click the up  
  arrow to add it as a page item.   
 
 

 
 

 
 
Tick/untick the Show Page Items checkbox to specify whether or not you wish the 
Page Items to display on the results page. 
 
Click on Apply the make the changes and the data is displayed with the new 
page item 
 

  

 
Moving columns left and right 
Use the right and left arrows to re-arrange the column order 
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4.5 Drill to Related Data 
 
Each column headings has a blue arrow. Clicking on the arrow brings up a 
Drill to listing. 
 
The list contains related items – other data fields that are related to the CUFS 
module being interrogated. In the example below, additional AP Invoice fields 
are offered in the Drill To list. 
 
When an item is selected, the query is refreshed and it is added to the data as 
an extra column. 
 
 

 
 
 
 
Hint:  The Drill to list shows all available data fields.  
 
Tip: Some fields may already be in the results but are not visible. Use  

the Rows and Columns  link to show or hide columns. 
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4.6 Formatting Data 
 
In the Tools menu, select Format 

 
 
The data can be formatted as bold, italic and underscore. Background colours 
and font colours are all changeable. In addition, the Viewer allows conditional 
formats to be set using functionality similar to Microsoft Excel. 
 
Conditional Formats 
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Stoplight formatting 
 
Click on the Stoplight link on the Tools menu. 
 
Choose the values above and below which you want to see highlighted red, 
yellow and green. Apply the formatting 
 

 
 
The selected column has stoplight colours applied 
 
 

 
 
 
Deleting stoplight and other conditional formats 
 
Click on the Conditional Format link above the data and click the Delete icon 
for the format you wish to remove 
 

 
 
           
 
 

Remember:  The original worksheet layouts and formats 
can always be restored by clicking on the  
Revert to Saved  link on the Actions menu  
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4.7 Sorting data and hiding columns 
 

Sorting 
 
In the Tools menu, select the Sort link. 
 
Data can be sorted on any column from the Sort drop down box. 
The order of sort can also be selected with the Order drop down box 
 

 
 
 

To achieve a more complex sort, on multiple columns, click the More… link 
 

 
 
Use the table to choose additional sort columns 
 
When all sorting options are selected, click the Apply button. 
 
 
Hiding Columns 
 
A column can be used for sorting but does not have to be displayed. Also, 
users may wish to hide columns regardless of whether they are sorting. 
 
To hide a column tick the Hide Column box.  
 
Cautionary note!  This method of hiding columns requires that the hidden 
column is part of the sort criteria – so may require two sorts, one being the 
desired sort for the report, the second being created just to hide the colum 
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4.8 Saving workbooks 
 
If you have made changes to a worksheet (e.g. you have re-sorted data or 
repositioned worksheet items), you can save these changes.  
If you own the workbook, you will overwrite the original worksheet.  
 
If you are not the owner of the workbook that contains the 
worksheet, you can Save a copy of the worksheet. 
 
If you change a worksheet and then switch to a different worksheet, Viewer 
prompts you to save the changes you have made or discard the changes. 
 
Steps 
 
Select Save or Save as from the Actions 
listing 
 
 
 
 
 
 
 

 
 



Finance Training  Page 18 
Discoverer Viewer User Manual 1.02 11g2 

5 Exporting Data 
  

 
5.1 Exporting to Excel 
 
 
From the Actions menu, choose Export. 
 
 
 

 
 
 
From the drop down list, choose Excel Workbook. Click on the Export button. 
 

 
 
Click on the View or save button 
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Open or Save the data in Excel. 
 

 
 
5.2 Print data (to PDF document) 
 
This option is useful when it is preferred to share data with no risk of it being 
further modified (as it can if shared for example as an Excel file). 
 

 
 

Printing 

You print a worksheet in Discoverer Viewer by generating a Portable 
Document Format (PDF) version of the worksheet and printing the PDF file in 
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Adobe Acrobat. Discoverer displays the PDF version of the worksheet for you 
to preview before you print it. 

1. Display the worksheet that you want to print.  
2. Select the Printable Page link to display the "Printable Page Options 

page: Content tab".  
3. (optional) Use the "Printable Page Options page: Content tab" to 

change the print settings, if required.  
4. (optional) If you want to preview a sample PDF version of the 

worksheet before printing the full worksheet, follow the steps in "How to 
preview worksheets before printing".  

5. Click Printable PDF to display the "PDF Ready page".  
6. Select the Click to view or save link to display the full PDF version of 

the worksheet in a separate browser window.  

Note: You can now view, print, or save the PDF file.  

7. In the separate browser window displaying the PDF file, choose File | 
Print to display the operating system print dialog and print the PDF file.  

Discoverer prints the PDF version of the worksheet.  

 

5.3 Email worksheet data 

 
 
From the Actions menu, choose Send as 
email.   
 
 

 
The data can be viewed before sending by clicking on View Attachment. 
 
Click Finish. 

http://download.oracle.com/docs/html/B13987_04/reference_dialogs.htm#BACCGJII
http://download.oracle.com/docs/html/B13987_04/reference_dialogs.htm#BACCGJII
http://download.oracle.com/docs/html/B13987_04/reference_dialogs.htm#BACCGJII
http://download.oracle.com/docs/html/B13987_04/getting_started.htm#CIHGFHHE#CIHGFHHE
http://download.oracle.com/docs/html/B13987_04/getting_started.htm#CIHGFHHE#CIHGFHHE
http://download.oracle.com/docs/html/B13987_04/reference_dialogs.htm#BACGDGIA
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6 Help and Support 
 
 
Helpdesk 
 
The Finance Division Reporting Team is the “module owners” for Oracle 
Discoverer.  
 
The Reporting Team are responsible for the development, release and 
management of workbook sharing. 
 
The team also provides helpdesk support for Viewer users…. 
 
Helpdesk email:  fin_reporting_helpdesk@admin.cam.ac.uk 
 
Helpdesk phone:  Ext 65098 
 
 
New User access 
Discoverer Viewer is accessed through a responsibility in CUFS Live. The 
department Key Contact should request the Viewer responsibility through the 
online web form at  

 
University of Cambridge: University Finance System: University Finance System - 
KEY CONTACTS 

 
 
Other Published information 
In addition to this user manual, there are Quick Reference Guides and lists of 
Frequently Asked Questions available at the following sites: 
 
Finance Training website under the section Further Use   
Finance Division website under the Reference section 
Financial Reporting website 

mailto:fin_reporting_helpdesk@admin.cam.ac.uk
http://ufs.admin.cam.ac.uk/keycont/
http://ufs.admin.cam.ac.uk/keycont/
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Appendix 1: Using graphs in Discoverer Viewer 
 
About using graphs 
 
The majority of users may prefer to create graphs after exporting data to 
Excel; however, if a workbook is to be printed to PDF, or shared with a 
colleague, the inclusion of a graph may enhance the information. 
 
Graph editing options 
 
You can edit a graph in Discoverer Viewer by: 

 changing the graph type 

 changing the graph size 

 enabling and disabling graph gradients 

 enabling and disabling 3D effects 

 changing the data area that is plotted on the graph 
 
Notes 

1. Graphs created by the workbook author are displayed in Discoverer 
Viewer.  

2. Users can select worksheet options to display or hide graphs 
 
How to edit a graph 
 
You edit a graph to change the style or appearance of the graph. For 
example, you might want to change the graph type from pie graph to bar 
graph. 
 
To edit a graph: 
 
1.  Display the worksheet that you want to analyze. 
 

If the worksheet contains a graph that is hidden, display the graph  
 
2.  Select the Graph link to display graph tools above the graph. 
 

 Use the graph tools to edit the graph as follows: 

 to change the graph type, select a graph type from the Type 
drop down list 

 to change the graph style, select a graph style from the drop 
down list next to the Type drop down list 

 to change the graph size, change the values in the Height and 
Width fields 

 to specify whether the 3D or gradient effect is applied, use the 
3D  

 Effect and Gradient check boxes. 
 
4. Click Apply to close the Conditional Formats (Table/Crosstab) page and 
display the worksheet. 
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Discoverer applies the format changes you have specified. 
 
Hint: Select the minus (-) icon next to the Tools label to hide the graph tools. 
 
How to display or hide a graph 
 
You display a graph to plot the currently displayed worksheet data in a graph. 
For example, you might want to plot the worksheet data in a pie chart. 
You hide a graph to remove it from the worksheet. 
 
To display or hide a graph: 
 
1. Display the worksheet that you want to analyze  
 
2. Select the Worksheet options link to display the Worksheet Options 
page 
 
3. To display the graph for the current worksheet, select the Graph check 
box. 
 
4. To hide the graph for the current worksheet, clear the Graph check box. 
 
5. Click Apply to close the Worksheet Options page and display the 
worksheet. 
 
Discoverer applies the format changes you have specified. 
 
Hint:  You can also use the Graph plus (+) and minus (-) icons to expand and 

collapse the graph. 


